
���

IBM System Storage DS3500 e EXP3500 - Guía de inicio
rápido e instalación en bastidor

Esta Guía de inicio rápido e instalación en bastidor explica el procedimiento básico para instalar el subsistema
de almacenamiento IBM® System Storage DS3500 y el alojamiento de almacenamiento IBM System
Storage EXP3500. La información que contiene este documento hace referencia a los subsistemas de
almacenamiento DS3512 y DS3524 y a los alojamientos de almacenamiento EXP3512 y EXP3524.

Para obtener más información sobre la configuración y el cableado del subsistema de almacenamiento
DS3500 y el alojamiento de almacenamiento EXP3500, consulte Guía de instalación, del usuario y de
mantenimiento de IBM System Storage DS3500 y EXP3500 proporcionada con el hardware.

Para obtener más información acerca de DS3500 y otros productos de IBM System Storage vaya al sitio
http://ibmdsseriestraining.com/.

Para obtener la información más actualizada acerca de los sistemas de almacenamiento en disco de IBM
System Storage, entre los que se incluyen todos los subsistemas de almacenamiento y alojamientos de
expansión de almacenamiento, visite http://www.ibm.com/systems/support/storage/disk.

Para obtener información de seguridad, consulte el documento multilingüe IBM Safety Information que se
incluye en el CD de documentación.

Directrices de instalación en bastidor
Consulte la información sobre seguridad y cableado que contiene el documento que se proporciona con el
armario de bastidor. Antes de instalar el subsistema de almacenamiento en un armario de bastidor, revise
las siguientes directrices:
v Se necesitan dos o más personas para instalar dispositivos de 18 kg (39,7 libras) o más pesados en un

armario de bastidor.
v Compruebe que la temperatura del aire de la habitación sea inferior a 35°C (95°F).
v No obstruya las rejillas de ventilación; normalmente habrá suficiente flujo de aire si deja un espacio

libre de 15 cm (6 pulg.).
v No deje espacios abiertos por encima o por debajo de un subsistema de almacenamiento instalado en

su armario de bastidor. Para evitar daños en los componentes del subsistema de almacenamiento,
instale siempre un panel de relleno para cubrir el espacio abierto y facilitar la correcta circulación de
aire.

v Instale el subsistema de almacenamiento o el alojamiento de expansión de almacenamiento en un
armario de bastidor con puertas perforadas.

v Inicie la instalación del dispositivo desde la parte inferior del armario de bastidor.
v Instale el dispositivo más pesado en la parte inferior del armario de bastidor.
v No extraiga más de un dispositivo del armario de bastidor al mismo tiempo.
v Retire las puertas y los paneles laterales del bastidor para facilitar el acceso durante la instalación.
v Conecte el subsistema de almacenamiento o el alojamiento de expansión de almacenamiento a una

toma de corriente debidamente conectada a tierra.
v No sobrecargue la toma de alimentación cuando instale varios dispositivos en el armario de bastidor.
v El subsistema de almacenamiento o el alojamiento de expansión de almacenamiento requiere 2 U de

espacio vertical en el armario de bastidor.

http://ibmdsseriestraining.com/
http://www.ibm.com/systems/support/storage/disk


Observe las normas de seguridad para levantar
objetos.

≥18 kg (39.7 lb) ≥32 kg (70.5 lb) ≥55 kg (121.2 lb)

Información de cableado y alimentación para NEBS (Network
Equipment-Building System) GR-1089-CORE
Los siguientes comentarios se aplican a los dispositivos de almacenamiento de IBM que se han diseñado
conforme a NEBS (Network Equipment-Building System) GR-1089-CORE.

Este equipo es adecuado para la instalación en:
v Recursos de telecomunicaciones de red
v Ubicaciones donde se aplica el NEC (NFPA 70 National Electrical Code).

PRECAUCIÓN:
El cableado interno del edificio (cableado) debe estar protegido y conectado a tierra en cada extremo
cuando se utiliza con el dispositivo de almacenamiento.

Nota:

v Los puertos internos del edificio de este equipo son adecuados para la conexión a cableado no
expuesto o interno del edificio o solo al cableado. Los puertos internos del edificio de este
equipo no se deben conectar metálicamente a las interfaces que se conectan a la OSP (planta
exterior) o su cableado. Estas interfaces están diseñadas para su uso como interfaces internas del
edificio únicamente (puertos Tipo 2 o Tipo 4 como se describe en GR-1089-CORE, emisión 5 o
revisión posterior) y requieren aislamiento del cableado OSP expuesto. La adición de protectores
primarios no es una protección suficiente para conectar estas interfaces metálicamente al
cableado OSP.

v El sistema alimentado con corriente alterna no requiere el uso de un dispositivo de protección
contra avalancha externo (SPD).

v El sistema alimentado con corriente continua emplea un diseño de retorno de CC aislado (CC-I).
El terminal de retorno de batería CC no deben conectarse al chasis o toma de tierra de la
estructura.

v El dispositivo de almacenamiento (alimentación de CC) está pensado para que se instale en una
Common Bonding Network (o red de malla) como se describe en GR-1089-CORE, emisión 5 o
revisión posterior.
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Lista de inventario
En la siguiente lista de inventario se describen los elementos necesarios para instalar el subsistema de
almacenamiento DS3500 o el alojamiento de almacenamiento EXP3500 en el armario de bastidor. Si
alguno de estos elementos falta o está dañado, póngase en contacto con el establecimiento de compra.

Notas:

1. En función del tipo de DS3500 y EXP3500, es posible que la caja de envío contenga materiales
adicionales que no se incluyen en la lista siguiente. Para obtener información sobre partes adicionales,
revise la lista de inventario en la Guía de instalación, del usuario y de mantenimiento de IBM System
Storage DS3500 y EXP3500 que se proporciona con el hardware y utilice dicha lista junto con la
información siguiente.

2. Los cables de interfaz del host, los cables Ethernet, los cables de señal de canal de fibra y los cables de
señal iSCSI pueden variar según el hardware y no se incluyen en la lista siguiente.

Una vez que desempaquete el software DS3500 o EXP3500, compruebe que dispone de los elementos
siguientes para el subsistema de almacenamiento o el controlador de expansión de almacenamiento.
v Unidades de disco duro o bandejas vacías (12 o 24) (El subsistema de almacenamiento o alojamiento de

expansión pueden traer hasta 24 unidades.)
v Controladores RAID (solo DS3500, hasta 2)
v Environmental Service Modules (ESM) (solo EXP3500, 1)
v Modelos de alimentación de CA:

– Fuente de alimentación de CA y unidades de ventilación (2)
– Cables de alimentación del bastidor (2)

v Modelo de alimentación de CC:
– Fuente de alimentación de CC y unidades de ventilación (2)
– Cables de puente de CC (2)

v Conjunto de hardware de montaje en bastidor (1), que incluye:
– Rieles de soporte (2) (para montaje a derecha e izquierda)
– Tornillos M5 ranurados de cabeza hexagonal y color negro (8)
– Arandelas M5 (6)
– Separadores de diámetro pequeño (8) (se suministran instalados, cuatro en cada riel)
– Separadores de diámetro grande (8)
– Tornillos M4 de cabeza plana (2)

Importante: Los modelos de alimentación CA DS3500 Y EXP3500 no traen los cables de alimentación CA
específicos por región. Debe obtener los cables de alimentación aprobados por IBM- para su
región. Los modelos de alimentación de CC DS3500 y EXP3500 no traen un dispositivo de
desconexión de 30A (interruptor) que se necesita para la conexión de alimentación CC de
-48V. Para obtener más información, consulte la Guía de instalación, del usuario y de
mantenimiento de IBM System Storage DS3500 y EXP3500.

Herramientas
Antes de instalar el DS3500 o EXP3500, asegúrese de que el área de instalación dispone de conexión a
Internet. Las herramientas necesarias para la instalación son las siguientes:
v Un carro para colocar el subsistema y sus componentes
v Un destornillador plano de 5 mm (3/16 pulgadas)
v Protección antiestática
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Nota: Opcionalmente, también puede utilizar un destornillador Phillips del número 2 y una llave
inglesa de 8 mm.
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Visión general de la instalación
La instalación del DS3500 o del EXP3500 requiere los siguientes pasos:
1. “Desembalaje del subsistema de almacenamiento”
2. “Instalación de los rieles de soporte” en la página 6
3. “Extracción de componentes del subsistema de almacenamiento o del alojamiento de expansión” en

la página 7
4. “Instalación del subsistema de almacenamiento o del alojamiento de almacenamiento en el armario

de bastidor” en la página 11
5. “Activación de los modelos de alimentación de CA” en la página 14
6. “Instalación del software” en la página 18
7. “Descubrimiento y configuración del subsistema de almacenamiento” en la página 19
8. “Obtención de documentación desde el sitio Web de soporte de IBM” en la página 19
9. “Actualización del firmware del subsistema de almacenamiento” en la página 20

10. “Configuración del subsistema de almacenamiento” en la página 20

Desembalaje del subsistema de almacenamiento

Declaración 4:

≥ 18 kg (39,7 lb) ≥ 32 kg (70,5 lb) ≥ 55 kg (121,2 lb)

PRECAUCIÓN:
Observe las normas de seguridad para levantar objetos.

Para desembalar el subsistema de almacenamiento o el alojamiento de expansión, realice los pasos
siguientes:
1. Con ayuda de otra persona saque el subsistema de almacenamiento o el alojamiento de expansión de

la caja de envío y colóquelo sobre un carro, mesa u otra superficie elevada.
2. Compruebe el subsistema de almacenamiento o el alojamiento de expansión para asegurarse de que

ha recibido todas las piezas necesarias. Consulte la sección “Lista de inventario” en la página 3
relativa a las partes que se incluyen con el subsistema de almacenamiento o el alojamiento de
expansión.

3. Tome los rieles de soporte derecho e izquierdo y los tornillos M5 para proceder a “Instalación de los
rieles de soporte” en la página 6.
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Instalación de los rieles de soporte
Notas:

1. Para distribuir el peso adecuadamente, instale los rieles de soporte del subsistema de almacenamiento
en la parte inferior del armario de bastidor.

2. Si está instalando un subsistema de almacenamiento asegúrese de dejar espacio libre por encima y por
debajo para los alojamientos de almacenamiento.

3. Los rieles de soporte vienen marcados con las iniciales “R” y “L” para derecho e izquierdo.

Para instalar los rieles de soporte izquierdo y derecho en el armario de bastidor, realice los pasos
siguientes.
1. Para comenzar con la instalación del riel de soporte izquierdo, afloje los dos tornillos de ajuste del

riel. Estos tornillos se utilizan para ajustar la longitud de los rieles.

2. Sujete la parte frontal del riel izquierdo contra la pestaña de soporte interior de la parte frontal del
bastidor y extienda la parte posterior del riel hasta la pestaña de soporte de la parte posterior del
bastidor. Los separadores de la parte posterior del riel encajan en los agujeros del armario de bastidor,
como se muestra en Figura 2.

Nota: Si el bastidor tiene agujeros cuadrados, sustituya los separadores de la parte frontal y posterior
de los rieles por los separadores de mayor tamaño que se proporcionan con el kit del riel.

Tornillos de ajuste del riel

Figura 1. Tornillos de ajuste de riel

Separadores

Figura 2. Colocación de los rieles de soporte en el bastidor
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3. Una vez posicionadas las pestañas del riel de soporte dentro de los rieles del bastidor, desde la parte
frontal del armario de bastidor inserte, con ayuda de un destornillador, un tornillo M5 en el segundo
agujero de la parte de arriba del soporte de montaje , tal y como se muestra en Figura 3.

Nota: Asegúrese de añadir una arandela entre un tornillo M5 y un agujero cuadrado de la pestaña de
montaje del bastidor.

4. Desde la parte posterior del armario de bastidor inserte, con ayuda de un destornillador, dos tornillos
M5, uno en el agujero del fondo y otro en el segundo agujero de la parte de arriba del soporte de
montaje posterior.

Nota: Asegúrese de añadir una arandela entre un tornillo M5 y un agujero cuadrado de la pestaña de
montaje del bastidor.

5. Repita del paso 2 en la página 6 al paso 4 para el riel de soporte derecho.

Extracción de componentes del subsistema de almacenamiento o del
alojamiento de expansión
Extraiga los controladores o ESM, las unidades de intercambio en caliente, y las fuentes de alimentación y
las unidades de ventilación antes de levantar el subsistema de almacenamiento el alojamiento de
expansión. Para reducir el peso del DS3500 o EXP3500 durante la instalación. Todos los componentes de
la parte posterior del DS3500 y EXP3500 están sujetos por una palanca con cierre de seguridad.

Para extraer los componentes, realice los pasos siguientes.

Nota: El subsistema de almacenamiento DS3500 y el alojamiento de expansión EXP3500 utilizan la misma
fuente alimentación, así que el proceso de extracción es idéntico para ambos.

Tornillo M5 (1)

Tornillos M5 (2)

Figura 3. Fijación de los rieles de soporte en el bastidor
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1. Extraiga las fuentes de alimentación:
a. Presione las pestañas de las palancas de liberación tal y como se muestra en la ilustración hasta

que la fuente de alimentación se deslice hacia afuera aproximadamente 0,6 cm (0,25 pulgadas).
b. Extraiga con cuidado la fuente de alimentación de la unidad y póngala a un lado.

2. Si tiene un alojamiento de expansión EXP3512 o EXP3524, extraiga los ESM o paneles de relleno:
a. Abra las dos palancas de liberación hasta que el ESM se deslice hacia afuera aproximadamente 0,6

cm (0,25 pulgadas).
b. Extraiga el ESM de la unidad y póngalo a un lado.

Fuente de alimentación

Palancas
de liberación

Figura 4. Extracción de una fuente de alimentación de un subsistema de almacenamiento DS3500 o de un
alojamiento de expansión EXP3500

Palancas
de liberación

ESM

1

2

ESM

Figura 5. Extracción de un ESM o panel de relleno de un EXP3512 o un EXP3524
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3. Si tiene un subsistema de almacenamiento DS3512 o DS352, extraiga el controlador o controladores:
a. Abra las dos palancas de liberación tal y como se muestra en la ilustración hasta que el

controlador se deslice hacia afuera aproximadamente 0,6 cm (0,25 pulgadas).
b. Extraiga con cuidado el controlador de la unidad y póngalo a un lado.

Palancas
de liberación

Figura 6. Extracción de un controlador de un DS3512 o DS3524

Bandeja de la unidad

Asa de la bandeja

Pestillo

Unidad de disco duro

Syste
m

Sto
ra

ge

Figura 7. Extracción de una unidad de disco duro de un DS3512 o un EXP3512
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4. Extraiga las unidades:
a. Marque las unidades para que pueda volver a instalarlas en su ubicación original.
b. Para abrir el pestillo de la unidad presione hacia abajo el asa de la bandeja de la unidad.
c. Eleve el pestillo hasta que quede totalmente abierto formando un ángulo de 90° con la parte

frontal de la unidad.
d. Extraiga la unidad de disco de la bahía.
e. Repita los pasos 4b para 4d cada unidad.

5. Para obtener más información acerca de la extracción de componentes consulte la Guía de
instalación,del usuario y de mantenimiento de IBM Systems Storage DS3500 y EXP3500 proporcionada
con los alojamientos.

Bandeja de la unidad

Asa de la bandeja

Pestillo
Unidad de disco duro

Figura 8. Extracción de una unidad de disco duro de un DS3524 o un EXP3524
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Instalación del subsistema de almacenamiento o del alojamiento de
almacenamiento en el armario de bastidor
Para instalar el subsistema de almacenamiento, realice los pasos siguientes:
1. Lea la información de seguridad que se proporciona con el subsistema de almacenamiento o el

alojamiento de almacenamiento.
2. Deslice la parte posterior del subsistema de almacenamiento o del alojamiento de expansión sobre los

rieles de soporte tal y como se muestra en Figura 9 para el DS3512 y EXP3512 y en Figura 10 en la
página 12 para el DS3524 y EXP3524.

Nota: Ni el DS3524 ni el EXP3524 utilizan las pestañas de alineación del riel de soporte.

Pestaña de alineación
(ambos lados)

Figura 9. Colocación de un DS3512 o EXP3512 en un bastidor
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3. Alinee los agujeros de montaje frontales de cada lado del subsistema de almacenamientos o del
alojamiento de expansión con los agujeros de montaje de la parte frontal de los rieles de soporte.

4. Ajuste el subsistema de almacenamiento o el alojamiento de expansión con un tornillo M5 en el
agujero de soporte de la parte frontal (no es necesario añadir arandela), tal y como se muestra en
Figura 11 para el DS3512 o EXP3512 y en Figura 12 en la página 13 para el DS3524 o EXP3524.

Figura 10. Colocación de un DS3524 o EXP3524 en un bastidor

Tornillos M5

Figura 11. Anclaje de un DS3512 o EXP3512 a un bastidor
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5. Fije la parte posterior de los rieles de soporte con dos tornillos M4 en los agujeros rasgados que se
encuentran fuera del subsistema de almacenamiento o del alojamiento de expansión.

Tornillos M5

Figura 12. Anclaje de un DS3524 o EXP3524 a un bastidor
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6. Instale las piezas frontales izquierda y derecha en el subsistema de almacenamiento o en el
alojamiento de expansión tal y como se muestra en Figura 13. Sitúe la ranura en la parte superior de
la pieza frontal por encima de la pestaña del reborde del chasis y, a continuación, haga girar la pieza
frontal hacia abajo hasta que se encaje en su lugar. Compruebe que la superficie interior de la pieza
frontal quede al nivel del chasis.

7. Instale los componentes del subsistema de almacenamiento o del alojamiento de expansión que se han
extraído anteriormente en “Extracción de componentes del subsistema de almacenamiento o del
alojamiento de expansión” en la página 7.

Activación de los modelos de alimentación de CA

Declaración 5:

PRECAUCIÓN:
El botón de control de alimentación del dispositivo y el interruptor de alimentación de la fuente de
alimentación no desactivan la corriente eléctrica suministrada al dispositivo. Es posible que el
dispositivo disponga de más de un cable de alimentación. Para eliminar cualquier corriente eléctrica
del dispositivo, asegúrese de que todos los cables están desconectados de la fuente de alimentación.

1

2

Importante: Debe seguir el orden tal y como se indica en el procedimiento siguiente. Para establecer
redundancia de alimentación para alojamientos con dos fuentes de alimentación, utilice al
menos dos unidades de distribución de alimentación (PDU) del armario de bastidor.
Distribuya las conexiones de alimentación de los alojamientos entre las diferentes PDU y, a
continuación, conecte las PDU a receptáculos de alimentación externos ubicados en circuitos
diferentes.

Para activar la alimentación CA del subsistema de almacenamiento, realice los pasos siguientes:

Pieza frontal
derecha

Pieza frontal
izquierda

Figura 13. Instalación de las piezas frontales

14



1. Conecte un cable a cada fuente de alimentación del subsistema de almacenamiento.
2. Conecte el otro extremo de cada cable al receptáculo de alimentación.
3. Encienda los interruptores, si corresponde.
4. Encienda los dos interruptores de todos los alojamientos de almacenamiento conectados y espere 60

segundos.
5. Encienda los dos interruptores del subsistema de almacenamiento.

Nota: Para apagar el subsistema de almacenamiento, realice los pasos anteriores en sentido inverso.
Apague primero la alimentación del subsistema de almacenamiento; después, apague la
alimentación de los alojamientos de almacenamiento.

Activación de los modelos de alimentación CC

Declaración 29:

PRECAUCIÓN:
Este equipo está diseñado para permitir la conexión del conductor de tierra del circuito de
alimentación al conductor de tierra del equipo. Si se realiza esta conexión, se deben cumplir todas las
condiciones siguientes:

v Este equipo debe conectarse directamente al conductor de electrodos de tierra o a un cable de tierra
desde una barra o bus conexiones de tierra a la que esté conectado el conductor de electrodos de
tierra del sistema de alimentación CC.

v Este equipo debe ubicarse en el mismo área inmediato (por ejemplo, los armarios adyacentes) como
cualquier otro equipo que tenga una conexión entre el conductor de tierra del mismo circuito de
alimentación CC y el conductor de de tierra, y también el punto de tierra del sistema CC. El sistema
CC no debe conectarse a tierra en otro lugar.

v La fuente de alimentación CC estará ubicada dentro de la misma ubicación que este equipo.

v No se encenderán ni apagarán dispositivos en el conductor de circuito de tierra entre la fuente CC y
el punto de conexión del conductor de electrodos de tierra.

Declaración 34:
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PRECAUCIÓN:
Para reducir el riesgo de descarga eléctrica o de peligros eléctricos:

v Este equipo debe instalarlo personal de servicio especializado en una ubicación con acceso
restringido, como define el NEC y la CEI 60950-1, primera edición, The Standard for Safety of
Information Technology Equipment (Norma de seguridad sobre el equipamiento de Tecnologías de
la información).

v Conecte el equipo a un circuito de tensión extra-baja de seguridad (CTES) conectado a tierra fiable.
Un CTES es un circuito secundario que está diseñado para que las condiciones defectuosas
normales y únicas voltaje del nivel de seguridad no hagan que aumente el voltaje del nivel de
seguridad (60 V de corriente directa).

v Incorpore un dispositivo ya disponible, aprobado y calibrado de desconexión en el cableado de
campo.

v Consulte las especificaciones en la documentación del producto para el calibrado del interruptor
principal para la protección frente a las subidas de tensión del circuito derivado.

v Utilice solo conductores de hilo de cobre. Consulte las especificaciones de la documentación del
producto para el tamaño de cable necesario.

v Consulte las especificaciones en la documentación del producto para los valores de par para las
tuercas de la terminal de cableado.

Para activar la alimentación del subsistema de almacenamiento CC, realice los pasos siguientes:
1. Asegúrese de que tanto los interruptores de encendido como los de apagado de las fuentes de

alimentación CC del subsistema de almacenamiento y todos los alojamientos de almacenamiento están
en la posición desactivada (off).

2. Conecte un cable de puente de CC a cada fuente de alimentación CC en el subsistema de
almacenamiento y a todos los alojamientos de almacenamiento adjuntos:
a. Utilizando la cinta proporcionada, ate el cable de la fuente de alimentación CC al riel para

proporcionar mayor sujeción al cable de alimentación.
b. Conecte el cable de alimentación CC a la fuente de alimentación. Consulte Figura 14 y Tabla 1 para

obtener más información acerca de las posiciones de las patillas conectoras.

Tabla 1. Conector de alimentación CC - descripción de las patillas

Número Función Color del cable de conexión de la alimentación CC

1 Patilla 1: - 48 V CC Marrón

2 Patilla 2: POS RTN Azul

3 Patilla 3: GND Verde/amarillo

c. Conecte el cable de 48V (marrón) del cable de alimentación CC a un dispositivo de desconexión
aprobado (interruptor) calibrado a 30 A. Se debe poder acceder con facilidad al dispositivo de
desconexión desde la parte trasera de la unidad DS3500.

Figura 14. Conector de alimentación CC - posición de las patillas
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Atención:

v El dispositivo de desconexión (interruptor) debe estar calibrado a 30 A.
v Asegúrese de que solo cables conductores de cobre de 10 AWG se utilizan para todos los las

conexiones entre los conectores de alimentación CC de DS3500 o EXP3500 y la fuente de
alimentación CC.

d. Complete el cableado desde el dispositivo de desconexión al terminal marcado como -48V de la
fuente de alimentación del circuito de tensión extra baja de seguridad conectado a tierra (CTES).
Conecte el cable POS RTN (azul) y el cable de tierra (verde/amarillo) del cable de alimentación
CC a las terminales marcadas como POS RTN y GND en la fuente de alimentación, según se
muestra en Figura 15.

Tabla 2. Descripciones del cable de la fuente de alimentación CC

Número Función

1 Patilla 1: - 48 V CC

2 Patilla 2: POS RTN

3 Patilla 3: GND

4 Fuente de alimentación CC

5 Dispositivo de desconexión (interruptor)

3. Después de conectar todos los cables de puente CC, conecte la alimentación en la fuente de
alimentación CTES CC de 48V.

4. Encienda los dos interruptores de todos los alojamientos de almacenamiento conectados y espere 60
segundos.

5. Encienda los dos interruptores del subsistema de almacenamiento.

Nota: Para apagar el subsistema de almacenamiento, realice los pasos anteriores en sentido inverso.
Apague primero la alimentación del subsistema de almacenamiento; después, apague la
alimentación de los alojamientos de almacenamiento. Por último, apague los dispositivos de
desconexión instalados en la cuente de alimentación CTES de -48V.

Figura 15. Cableado CC desde DS3500 al dispositivo de desconexión y a la fuente de alimentación CC
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Instalación del software
Hay dos tipos de sistemas asociados al subsistema de almacenamiento. Los host envían señales de
entrada/salida (E/S) a los números de unidad lógica (LUN) del subsistema de almacenamiento. Las
estaciones de gestión gestionan el subsistema de almacenamiento. Un sistema puede funcionar como host,
como estación de gestión o como ambos. Esta sección le servirá como guía para instalar el software IBM
System Storage DS Storage Manager en una estación de gestión o en un host.

Nota: La versión más reciente del software Storage Manager para su sistema operativo se encuentra en el
sitio Web de soporte de IBM. Para obtener más información, consulte “Obtención de
documentación desde el sitio Web de soporte de IBM” en la página 19. Es posible que la versión
del software que incluye el DVD DS Storage Manager suministrado con el subsistema de
almacenamiento no sea la versión más reciente.

Instalación del Storage Manager en una estación de gestión
Para instalar el software Storage Manager en una estación de gestión, realice los pasos siguientes:
1. Si dispone de acceso a Internet, descargue la última versión del software Storage Manager del sitio

web de soporte de IBM (consulte “Obtención de documentación desde el sitio Web de soporte de
IBM” en la página 19 para obtener más información). Si no dispone de acceso a Internet inserte el
DVD DS Storage Manager en la estación de trabajo de gestión y acceda al directorio correspondiente en
su sistema operativo.

Nota: El tipo de sistema operativo que ejecute la estación de gestión es el directorio en el que se debe
ubicar el DVD de DS Storage Manager. Para obtener más información, consulte los archivos
léame del sistema operativo y del controlador de dispositivo que encontrará en el DVD DS
Storage Manager.

2. Pulse dos veces en el archivo ejecutable de Storage Manager. Siga las instrucciones del asistente de
configuración y asegúrese de seleccionar una de las opciones siguientes cuando así se le solicite:
v Seleccione Estación de gestión si el sistema se va a utilizar solamente como estación de gestión.
v Seleccione Típica (instalación completa) si el sistema se va a utilizar como estación de gestión y

como host.
3. Si este sistema es el único sistema designado como supervisor, seleccione Automatically Start

Monitor cuando así se le solicite.

Nota: Si otros sistemas van a gestionar el subsistema de almacenamiento, no seleccione Automatically
Start Monitor al configurar dichos sistemas. En lugar de eso, seleccione Do Not Automatically
Start the Monitor cuando así se le solicite. De lo contrario, se enviarán varias notificaciones de
alerta cuando se produzcan problemas con los subsistemas de almacenamiento.

Instalación del software en un host
Para instalar el software en un servidor de host, realice los pasos siguientes:
1. Compruebe la versión del sistema básico de entrada y salida (BIOS) del adaptador de bus de host

(HBA) y la versión del controlador de dispositivo para sus HBA actuales. Antes de instalar el software
actualice, si es necesario, las versiones al nivel actual que se muestra en el sitio Web de soporte de
IBM (para obtener más información consulte la sección “Obtención de documentación desde el sitio
Web de soporte de IBM” en la página 19).

Nota: El sistema básico de entrada y salida (BIOS) y los controladores de dispositivo para sus HBA
deben obtenerse directamente del sitio Web de soporte deIBM. Para obtener más información,
consulte la sección “Obtención de documentación desde el sitio Web de soporte de IBM” en la
página 19.
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2. Instale el controlador multivía para gestionar las rutas de acceso desde los HBA del host hasta los
controladores del subsistema de almacenamiento. Para obtener más información, consulte la Guía de
instalación y soporte de host de IBM System Storage DS Versión 10.

Descubrimiento y configuración del subsistema de almacenamiento
Para descubrir y configurar el subsistema de almacenamiento, realice los pasos siguientes:
1. Inicie el software Storage Manager desde su estación de gestión. A continuación, se abrirán las

ventanas Enterprise Management y Confirm Initial Automatic Discovery.
2. En la ventana Enterprise Management, seleccione Automatic Discovery para descubrir el subsistema

de almacenamiento. Una vez finalizado el proceso de descubrimiento automático inicial, en la ventana
Enterprise Management se visualizan todos los hosts y subsistemas de almacenamiento que están
conectados a la subred local.

Nota: Para descubrir subsistemas de almacenamiento que se encuentren fuera de la subred local,
seleccione Edit > Add Storage Subsystem y especifique manualmente la dirección IP del
controlador del subsistema de almacenamiento o la dirección IP de un host remoto.

3. Seleccione Rename the Storage Subsystem. Utilice el número de serie del DS3500 como primera parte
del nombre del subsistema. El nombre de host tiene un máximo de 30 caracteres.

4. Pulse Locate the Storage Subsystem. El indicador LED azul del subsistema de almacenamiento
seleccionado parpadeará. Asígnele al subsistema de almacenamiento su nombre asociado.

5. Marque el subsistema de almacenamiento y seleccione Tools > Manage Storage Subsystem para abrir
la ventana Subsystem Management y el Task Assistant.

6. Si el subsistema de almacenamiento no se encuentra en estado Optimal, pulse el icono Recover from
Failure del Task Assistant. Siga los pasos del Recovery Guru. Una vez que el estado del subsistema
sea Optimal, cierre el Task Assistant.

7. En la ventana Subsystem Management, seleccione Storage Subsystem > View > Profile. Pulse las
pestañas Controller Firmware, NVSRAM, ESM Firmware, Drive Product ID, y Firmware Versions, y
anote todos los números en la tabla siguiente para utilizarlos en el futuro.

Controller firmware:

NVSRAM:

ESM firmware:

Drive product ID:

Firmware versions:

8. Guarde el perfil para utilizarlo en el futuro y cierre la ventana de perfil.

Nota: Guarde un copia del perfil del subsistema de almacenamiento y del paquete Recopilar todos los
datos de soporte cuando realice cambios en la configuración de los subsistemas de
almacenamiento.

Obtención de documentación desde el sitio Web de soporte de IBM
La documentación de IBM System Storage descrita en esta Guía de inicio rápido y la información adicional
acerca de IBM System Storage se encuentran en el sitio Web de soporte de IBM. Para acceder a la
documentación más reciente, descargas y otras actualizaciones técnicas en el sitio Web de soporte de IBM,
realice los pasos siguientes.

Nota: Periódicamente se realizan modificaciones en el sitio Web de IBM. Los procedimientos para
localizar firmware y documentación pueden variar ligeramente con respecto a los descritos en este
documento.

1. Vaya a http://www.ibm.com/systems/storage/support/.
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2. En Select your product, en el campo Product Family, pulse Disk systems.
3. En el campo Product, seleccione el nombre de producto correspondiente y, a continuación, pulse Go.
4. En Support & downloads, seleccione la categoría de soporte correspondiente.

Nota: Para obtener información detallada acerca del controlador de dispositivo y versiones de firmware,
consulte los archivos léame que se proporcionan con cada paquete.

Actualización del firmware del subsistema de almacenamiento

Nota: El código de host, el sistema básico de entrada/salida (BIOS) de HBA y el controlador de
dispositivo del software Storage Manager son válidos si se han realizado los pasos descritos en
“Instalación del software” en la página 18.

En la ventana Subsystem Management, pulse Advanced > Maintenance > Download y seleccione las
opciones siguientes en el orden que se indica a continuación:
1. Controller firmware
2. Controller NVSRAM
3. ESM firmware
4. Drive firmware

Configuración del subsistema de almacenamiento
En la ventana Subsystem Management, pulse View > Task Assistant. Si el subsistema es Optimal, realice
las tareas siguientes en el mismo orden:
1. Configure notificaciones de alerta para problemas en el subsistema de almacenamiento
2. Defina los hosts
3. Cree nuevas particiones de almacenamiento
4. Guarde la configuración
5. Establezca o modifique la contraseña
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Esta edición se aplica a los subsistemas de almacenamiento IBM System Storage DS3500 y EXP3500 con el firmware
de controlador versión 7.70 y a todos los releases y modificaciones posteriores hasta que se indique lo contrario en
nuevas ediciones.
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